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CHAPTER ONE

L157 Open Box

1) The Package Information
The original package comes with film wrapped, and have bar code information
Package List
 1 x L157 Machine
 1 x Earphone
 1 x USB Cable (for data transfer and charging)
 1 x VIP Card

We highly recommend you register at our site to receive an extended warranty (18months), to
verify the product authentication, and to have better customer service. Registration is free.
Register VIP: http://www.evistr.com/vip or email support-us@evistr.com to register VIP and
receive an extended 18 Month Product Warranty.

2) The Operation Guide Explain

Earphone Jack

USB Socket

POWER button

REW/FF select button

Vol + / Vol -

REC: Recording

PLAY: Playback

STOP: Save recording / RETURN

MENU: Menu, confirm, A-B repeat

http://www.evistr.com/vip
mailto:support-us@evistr.com
http://blog.evistr.com
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Learn how to operate the buttons in the product sketch.

Built-in Mic: Captures the voice and records. Do not click on buttons when device is recording.

Earphone: You may plug in earphones to hear the playback.

USB: For charging or to download recordings to a computer.

POWER Button: Switch on/off device power (we recommend you keep power button at ON

position unless storing the device).

PLAY/PAUSE: Play recordings or turn on/off the device (while power button is at the ON

position).

REC: Button for recording.

STOP: Save recording, stop playback。

M:Menu options. Use up/down to select, use M to confirm. Press Stop to return to main menu

Speaker: Device has a built-in speaker. You can hear the playback without earphones.

UP/DOWN: Selects Menu Options.

VOL+ / VOL- : Adjusts the speaker volume. When setting date and time, use this button.

Operational Explanations:
These instructions will say “hit” or “press down.”
Hit: a short press of the button.
Press and hold: press the button a few seconds until the screen shows the information.

3) Quick Start Guide

Turn ON device: Power button to ON position; press PLAY button for two seconds to turn on the

device.

Recording: press REC button to begin recording.

Save Recording: press STOP button to save recording

Delete Recording: pressMenu button. Select -> Delete File -> select Delete. This deletes a single

recording. To delete all files, go to -> Delete File -> Use Up/Down button to choose Delete All.

Use Up/Down button to confirm your choice.

http://blog.evistr.com
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Play a Recording: Choose the recording you wish to hear by pressing Menu -> use Up/Down

button to choose, press PLAY.

Play Next / Previous Recording: press the Up/Down button.

Fast Forward / Rewind: press and hold the Up(REW)/Down(FF) button.

4) Quick Menu Option Guide Using UP/Down Button

To select and confirm, press Menu (M) button.

Change Record Format/Quality: go to Menu (M) -> Up/Down button to select Record Setting ->

Recording quality -> (1536kpbs WAV format, 128kpbs / 64kpbs MP3 format)

Voice Activated Mode (AVR mode): go to Menu (M) -> select Record Setting -> Up/Down

button to Voice-activated mode-> M button to select AVR mode -> select ON.

Voice Activated Level: go to Menu (M) -> Up/Down button to select Record Setting -> select

Voice activated sensitivity -> select from levels 1 to 5.

Set Time: go to Menu (M) -> Up/Down button to select System setting -> Up/Down button to

select Date and time -> select Set time -> use Up/Down and VOL+ buttons to change time.

Press M button to confirm.

Set Date: go to Menu (M) -> Up/Down button to select System setting -> Up/Down button to

select Date and time -> select Date -> with Up/Down and VOL+ buttons change date, and press

M button to confirm.

5) Important Notice for Using The Device

 Do not shut down the device’s power button when it is saving a recording.

 Do not scratch the recorder body.

 If typing or writing near the device while record function is on, it will capture the noise.

 Do not format the device unless the files have been backed up.

 Do not cut off power while formatting device.

 Do not delete a file unless the file has been backed up.

http://blog.evistr.com
mailto:support-us@evistr.com
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 Do not press any buttons when device is connected to a computer.

 Do not use non-original micro USB cable to transfer data from device to computer. Not all

micro USB cables support data transfer.

 Do not set View Playing unless needed. It only plays 10s seconds of each file.

 Do not use the Voice Activated Function unless needed. It may not record some low decibel

voice you want recorded.

 Do not turn on the sleeper time function unless needed, as this will force the device to shut

down, even if in use.

 Do not pause the device for a long time, as the device will automatically shut down when

there is no operation such as playing or recording.

CHAPTER TWO

L157 Basic Operation Guide

1) Charging Voice Recorder

Connect it to computer with enclosed cable, it will charge, once it has finished charging ( typically
around 1.5-2 hours), we could eject the device from the USB port

We can also connect the voice recorder to other USB socket for charging (like USB wall charger, USB
charge dock)

Charging Input: 5V 500mAh

2) Turn On Voice Recorder

Simply push the power button (at left side ) to “ON” position, it will boot up ( screen light on, and
see EVISTR logo )

Switch it back to “OFF”, it will shut down

http://blog.evistr.com
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See below picture

ON: push up the power button to ON position OFF: push it down to OFF position, totally shut
down

3) How to Recording
Press & hold PLAY button power on the voice recorder (NOTE: keep the left side POWER switch at
ON position, if it is at OFF position, we need to push it to ON position first)

Press REC, it starts to record

Press STOP, it saves the recordings

NOTE: we recommend that you push the POWER button up to the ON position to
turn on the device. Unless storing the device, we recommend you turn on/ off the
device by pressing down the PLAY button.

http://blog.evistr.com
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1) Press & hold PLAY to turn ON 2) Press REC, to record

3) Press STOP, save recordings

NOTE: press STOP to save recording every time
when complete a recording task.

If, for example, we press REC and STOP 3 times, the recorder will create 3 recorded files
corresponding to each time, and they will typically be named

Each recordings will be saved a file names with date in sequence, but it has a time stamp

If we want to see the recorded date of file “20180510162305.MP3”, we could click right button and

http://blog.evistr.com
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view file properties, we will see the recordings file time

File Name Format: Year-Month-Day-Hour-Minute-Seconds

See the right side picture shows:

6) How to Pause and Resume Your Recording

During recording, press PLAY pause recording

Press PLAY again, resume recording

Note: do not pause a recording task in long time, it will
automatically turn off the device (power saving function)

7) How to Playback Recordings

Press and Hold PLAY boot up the voice recorder

Press PLAY, playback the latest recordings.

We could press UP/DOWN button to select the recordings which need to playback.

1) Press & Hold PLAY, open your voice recorder 2) Press PLAY to playback the recordings

NOTE: If it reads MUSIC folder, We could press and hold STOP (and wait a
moment) to switch betweenMUSIC and RECORD folder

http://blog.evistr.com
mailto:support-us@evistr.com
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8) How to Fast Forward / Rewind
During playback, Press and Hold UP / DOWN to rewind / fast forward

9) How to Delete Recordings

Delete recordings, it could have 5 method
A. Format the recorder EVISTR L157 disk on your WINDOWS computer directly (all data will be
erased completely)
B. From computer, go to EVISTR L157 disk, find folder “RECORD”, select the recordings you want to
delete on computer
C. Format the recorder on the device directly
D. Delete single file on the device by enter delete mode
E. Delete all recordings on the device by enter delete mode

Now we introduce how to delete recordings on the device by enter delete mode. In pictures ,we
introduced how to Delete single recordings, and how to delete all recordings

Press M(menu) button -> Delete File -> Delete, it will delete the currently file

Select Yes, press M to confirm your selection, it will delete the recordings as your selection

Note: We could press UP/DOWN to select recordings firstly, and then press M to select delete file

10) How to Playback Music
By pressing PLAY button turn on the voice recorder

Press and hold STOP, switch to music folder ( if you are at recordings folder)

Press PLAY to playback music

Notice:
 if it shows “no songs” that mean there is no songs file in the recorder, or the song file format

are not supported.

Menu Options
Delete file
Play setting
Folder View

Delete File
Delete
Delete All

“201805101...
Yes
No

http://blog.evistr.com
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 Press and hold STOP button for 3 seconds, and then release the STOP button, wait a moment, it
will switch back to recordings folder

11) Restore to Factory Settings

Restores to factory default. Very helpful if confusion arises when creating settings.

Here is the steps to restore to factory settings
Press Play (turn on device) -> hit M -> use Up/Down to System Settings -> hit M
Find & select "Factory Settings"
Press M(menu), enter it, find & select “Yes”
Press M (menu), confirm your selection, and it starts to restore to factory settings.
When it succeed, screen will show “restored!”

12) Format Device

Format on the device directly
Here is the steps to format the recorder
Press Play (turn on device) -> hit M -> use Up/Down to System Settings -> hit M
Find & select "Format Device"
Press M , enter it, find & select "Yes"
Press M , confirm your selection, and it starts to format

Screen will show “please wait”, after format completed, the device will restore settings, and reboot.
Do not shut down the device, until this procedure completed

Restored!

Format finish,
reset...

Menu Options
Folder View
Record Se...
System settin

Format ?
Yes
No

System set
Information
Format Devic
Factory s...

Please wait..

Menu Options
Folder View
Record Se...
System settin

Menu Options
Information
Format de...
Factory setti

Restore
Yes
No

No voice
recordings

EVISTR
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WARNNING:
When format device, do not cut down the device power, unless formatting completed, and the
device could operate again
Backup all files you need before format the device, once format completed, all data will be erased
and cannot restore.

13) How to Connect to Computer

Use the enclosed Micro USB cable connect it between your computer and voice recorder, when
successfully connected, you will see the connection icon, see as following picture

After we successfully connected to a computer, we could delete the files in the recorder, copy file
from the recorder out to computer, copy file into voice recorder device, it just like a normal flash
drive

1) Successfully connected to computer 2) We will see EVISTR L157 on our computer

14) Format EVISTR L157 Drive on Computer Directly

.When successfully connected to computer, click the mouse right button, and format it, like below
picture shows:.

http://blog.evistr.com
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Notice: all data will be erased completely, so please backup before formatting device
15) System Time & Date Setting
Turn on the voice recorder
Press M (menu), find & select " System Setting"
Press M(menu), enter System Setting, find & select "Date and time"
Screen will display “set time”, “set date”
Set Time

1) Select Set time, Press M 2) Press UP / DOWN to adjust hour,

Press VOL+ / VOL- move to next

3) Press UP / DOWN to adjust

Minutes, After setting Press

M(menu) to confirm

Set Date

4) Select Set Date, Press M 5) Press UP / DOWN to adjust Year,

Press VOL+ / VOL- move to next,

month & day

6) After setting, Press M(menu) to

confirm

Set date

HH MM

YY MM DD

18 05 30

Set timeDate and time
Set time
Set date HH MM

Date and time
Set time
Set date

Set time

16 42

YY MM DD

17 42

Set date

18 05 30

http://blog.evistr.com
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Now we have successfully set time and date for the recorder

16) Go to Setting (Menu Options)

At the status of stop recording and playback, you could press M (menu), entermenu options

The buttons will performs like this
UP,DOWN: for selection
VOL+, VOL-: for move to next when in time setting
M(menu): for confirm selections
STOP: return back

I have met some issues with my voice recorder, don’t worry, don’t give up just yet and assume that it
is defective

At Chapter FIVE, we offer some very common trouble shooting, just have a quick look, based on our
customer feedback, mostly issues could be solved from trouble shooting guide.

If cannot get the issue fixed, don’t be hesitated to contact support-us@evistr.com with the order ID,
model number, so we could help to solve the question more effectively.

All products with 1 year warranty, and Customer satisfaction was guaranteed.

CHAPTER THREE

L157 Advanced Operation Guide

1) Record Setting
1.1 Recording Quality
At recording quality setting, it could select recording quality at 1536kpbs (WAV format),
128kpbs (MP3 Format), 64kpbs (MP3 format)

1.2 Record Led
ON: default. LED indicator light is ON. OFF: turn off the LED indicator light.

1.3 Subsection Recording

mailto:support@evistr.com
http://blog.evistr.com
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At subsection recording, it could select Half hour, One half, Two hour, CLOSE

What is subsection recording?
Recorder will automatically save the recording file at a selected time length and start a new
recording.
Half Hour: record each file at 30minutes.
One Hour: record each file at 1 hour.
Two Hour: record each file at 2 hour.
CLOSE: turn off subsection record function.

e.g. When select Half hour, each time, recording time length reached 30minutes, it will
automatically save the recording, and then start a new recording.

If want to close this function, select CLOSE, and press M(menu) to confirm & save settings.

1.4 Voice Activated Recording
What is Voice Activated Recording?
When AVR mode is ON. Press REC, screen will display VOX information, it means the device
successfully enter voice activated recording mode.

Voice Activated Mode (AVR)
When AVR is on, device will record any voice. If no voice is detected, it will not record to reduce
blank time and save storage space.

At AVR mode, we still need to press STOP to save recordings when we complete a recording
task.

AVRMode
ON: turn on voice activated record function.
OFF: turn off voice activated record function.

Voice Activated Sensitive Level
From Level 1 to Level 5: Level 1 only picks up voice or sound above 70db, a very loud sound.
Level 5 is very sensitive, so any quiet sound will be recorded. (i.e. normal environmental noise
will activate recording).

Note: do not turn on this function for important lectures or meetings. It may skip or lose some
very important sentences at low decibels. Use regular on/record/stop for meetings.

It could select from level one to level five
Level one, is the mostly dumb level, it means the mic will be less sensitive, need louder voice to

http://blog.evistr.com
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active the recording, otherwise, the recording time is not counting, and it was pause recording.

While level five, is the mostly sensitive level, it means the mic is very sensitive, just a soft
speaking will be captured. It will be almost continuously recording, cannot see pause status.

NOTICE:
 When voice activated recording is ON, during recording screen will show VOX
 During recording, if no voice detected, the time will not counting, that means the recorder was

automatically paused recording, when voice detected again, it will resume recording
automatically

 Select desired MIC sensitive level according to demanding

1.5 Record Monitor
ON: when ON, use earphones to hear what it is recording.
OFF: turn off this function.

1.6 Exit
Exit record setting, return to up level menu

2) System Setting
2.1 Sleeper timer
When select sleeper time, it will force the device to be automatically switched off.
The options: OFF, 10minutes, 30minutes, 60minutes, 90minutes, 120minutes

2.2 Backlight timer
Backlight timer, it will control how long the screen will light up without any operation.
The options: 20seconds, 30seconds, Always on
Notice: we do not recommend to select at always on, because this will consume the battery
very fast

2.3 Brightness
Brightness: adjust the screen from dark to bright
The options: from 00 to 15
Notice: higher number means the screen will be brighter, and need to press M(menu) to
confirm the changes, otherwise the setting will not be effective.

2.4 Date and time
Set the system time of the recorder (set time, and set date)
UP/DOWN: to adjust the hour, minute, year, month, day
VOL+/VOL-:move to next
Notice:

http://blog.evistr.com
mailto:support-us@evistr.com


EVISTR VOICE RECORDER
http://blog.evistr.com support-us@evistr.com

Page - 18 - of -25 -

Once set the correctly time, remember press M(menu) to confirm the changes.

2.5 Language
Change the device display language

2.6 Information
Player Information: it will show the device firmware version, and system firmware released
date
Disk Space: it will show the free space, and total space of the built-in memory

2.7 Format Device
Format device, it will erase all data on the device, and cannot be restored forever
Notice:

 Do not format the device unless you have already backup the data on the device to computer,
and you are sure about this.

 Do not cut off its power during format the device, otherwise it will meet disk error
 During format device, wait till showing completed information, and the device reboot, and then

you could switch off the device.
 If unfortunately, cut off device power, and see DISK ERROR, Here is the rescue:

Please kindly cut off the device POWER from ON to OFF position, and connect to
WINDOWS computer, format the disk again from computer, and then things will be normal. And
all data will be erased thoroughly. (for MAC computer need to contact customer for tutorials)

2.8 Factory settings
Factory settings: Restores to factory default. Very helpful if confusion arises when creating
settings.

Enter to Factory Settings, screen will show
“ Restore

Yes
No”

When select Yes, and press M(menu) to confirm the choice, so all settings will be restored to
default. Screen will show “Restored!”

3) Play Setting
3.1 Play Mode
Repeat:
Repeat off, Repeat One, Repeat All
Repeat off: select and confirm this, it will play in normal, from first recording to the last one
Repeat One: select and confirm this, it will repeat on single track again and again
Repeat All: select and confirm this, it will repeat from A-Z again and again

http://blog.evistr.com
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Shuffle:
When shuffle is on, it will playback all recordings or music in random, even you press UP/DOWN,
it will not select to next or previous track, it will be random.

3.2 Sound Setting
Sound Settings could adjust Equalizer (off, Rock, Pop, Soft, Jazz, Classical, Techno), Select and
confirm changes, it will becomes to effect.

4) Folder View
It will show how many folders on the recorder disk, and what kind files on the recorder

CHAPTER FOUR

1) Failed Connect to computer

Sometimes, you may met the failed connect to computer issue, it is normal like you failed connect
your flash drive to computer, so the solutions are same way for solve it. Here are some suggestion
for you fix this issue

A. Before connect voice recorder to computer, switch OFF the voice recorder
B. When connect the voice recorder to computer, do not press any buttons on the voice recorder, it
will exit connection mode
C. Do not swing the Micro USB cable when connect to computer, in case of unstable connection
D. Sometimes failed connection due Micro USB cable is broken or USB socket is loose, change a new
cable (like your android phone cable) or connect by another USB socket, or simply reboot your
computer
E. Even worse, still failed connection, here is an advanced solution

We could do debug as following:

http://blog.evistr.com
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1) On your computer, go to Computer manage 2) Computer Management

3) Find Device Manager

4) Click right mouse button, enable the recorder
device / or scan update hard drive changes to
help you find the recorder drive

If we still meet the failed connect to computer issues, please kindly contact to us
support-us@evistr.com
We will help soon.

CHAPTER FIVE

TROUBLE SHOOTING

1) No Voice Recordings
If there is no voice recordings, or you have deleted all recordings in your device, you will see “ no
voice recordings” or “no songs” on the screen. Don’t worry, you could just go ahead to press REC.

mailto:support-us@evistr.com
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2) How to Close Record Light
Go to record setting -> Record led -> select close(OFF), so when recording, the record light will not
light up or flash

3) Format Error
Format Error, this usually happens from 3 aspect:
A. During recording, directly push down the POWER BUTTON to OFF position, that will cause file
damage, we need to press STOP save the recordings firstly
B. The recordings time length is less than 5 seconds, like ZERO second recordings file
C. Computer do not support the .wav file. The recordings were saved as .wav format. For WINDOWS
10 or MAC user may encounter with this issue. Don’t worry
You could download the free MplayerX / VLC Media Player to solve this issue
http://mplayerx.org/
http://www.videolan.org/vlc/
D. Try to Record at MP3 format, so it will be more widely supported by different computers

4) Disk Error
Due static shock, like over current charging, cut off its power when format device didn’t completed,
so it lost system firmware.

How to Rescue:
Keep its power button at OFF position, connect to windows computer, and format the recorder disk
again, things will be normal (for mac computer, contact customer support for tutorials)

5) How to connect to computer
Use the attached cable connect to your computer, or your android phone cable

If you failed connect it to your computer, you could contact us, support-us@evistr.com we will help
you solve it.

6) Can I delete recordings from computer
Yes, when the recorder was successfully connected to your computer, you should find it as an
removable drive names as “L157”, and all your recordings was saved in a folder names “RECORD” in
the drive.

You could delete file or copy file into it, same as your ordinary USB Flash Drive.

7) When Connect to computer, the buttons not work
When connected to computer, it will enter connection mode, the device screen will show the
“CONNECTION ICON” like the CHAPTER TWO, POINT 13 picture shows.

http://mplayerx.org/
http://www.videolan.org/vlc/
mailto:support-us@evistr.com
http://blog.evistr.com
mailto:support-us@evistr.com
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All buttons will not work at this situation, if you press M and hold it, it will exit connection mode,
and will be failed to connect to your computer.

8) Cannot find my recordings in the recorder

This mainly caused by the device reading the MUSIC folder, you could press and hold STOP switch
back to RECORD folder

Or connecting computer, and check whether there is recordings in the device or not.

9) How to Turn ON Voice Activated Function
Go to Menu Options, find record setting, enter it -> Voice Activated Setting -> AVR mode -> ON, and
press M confirm it.

Now pressing REC, the screen will show VOX, it means you have successfully set voice activated
recording function

10) How to Use the AVR Mode (Voice Activated Function)
When AVR mode is ON, the recorder will enter voice activated recording mode.
It will only picks up loud enough decibels voice (any sounds).

So we could select the best AVR level as we want, and get the best effect of voice activated
recording.

For L157 voice recorder, the AVR level could be selected from 1 -5; The lower number means need
higher decibels voice to activated the recorder, and it need louder voice; At level 5, it is very
sensitivity, only a very low decibels or quiet speaking could be picked up.

Also, when voice activated function was ON, press REC, it will record 3 seconds, the device run 3
second to check the recorder was corrected entered recording mode. And then it will only pick up
loud enough decibels voice / sound.

11) Press REC, it not recording
First check, the recording light blink or not

Second, can you see VOX on the screen, If so, we suggest you could close the AVR mode, if you do
not want this function

Third, confirm if there is enough free space on the device.

http://blog.evistr.com
mailto:support-us@evistr.com
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12) Press REC, it shows “OVER RECORD”
When press REC, it not records, it show “OVER RECORD”, that means the voice recorder memory is
full, or you have too many “FOLDER” or “recordings” in the recorder.

Why this happened? Although you may not record too long time. Sometimes mistakenly RECORD,
and SAVE again and again, or copy or create too many “FOLDER” in the recorder disk. Maybe there is
some files that cannot be read by the recorder, so you cannot find directly from the recorder

So you need to format the voice recorder, or connect to computer and have a check, after that
format the recorder disk from your computer directly

13) Why it is only playing 10 seconds

This is because you have entered view playing playback mode, it will playback 10seconds of each file

At the status of playback, you could pressM (menu), find Repeat, enter it

Select Repeat All or other mode, pressM (menu), confirm your setting

14) Why it playback in random

Same way to solve this issues as issue 12, go to play setting, close the shuffle function

15) How to use the A-B repeat function
During playback, press and hold M, you will see A on the screen, and B is blink, it selected the start
point

Press and holdM again, select point B

Now it will playback between Point A to B

16) The recording is noise
Don’t recording near computer, electric fans, air conditioner, sound bar that will easily cause noise,
the recorder will pickup this statics noise

17) The recorder auto shut down when I am recording
Why this happened? The sleeper time function is ON, when set this, no matter you are operating the
device, or recording or playing, it will force to shut down the device.
So you could go to System setting - > sleeper time, select OFF and confirm it. You will close the sleep
time function. In default, it was at zero.

http://blog.evistr.com
mailto:support-us@evistr.com
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So you could also try to restore to factory setting when this happened, if not sure how to set the
sleeper time.

18) I Cannot Shut Off My Voice Recorder
When the recorder is charging, or connected to computer, even when the POWER BUTTON ON/OFF
was at OFF position, it will still be ON, and you cannot shut off the voice recorder at this status
(because the voice recorder directly get power from charging socket or computer)

19) How to format the recorder
Press M (menu), enter menu
Select System Setting, press M (menu), enter it
Select Format Device, Press M (menu), enter it
Enter Format Disk, select Yes
Press M (menu), confirm and start to formatting, after formatting completed, all files on the recorder
will be deleted, and now you will get your 8GB storage on your voice recorder back.

Do not shut off the device during format disk

20) Space is full
When space is full, you can connect to your computer and back up all the files to your computer, and
then delete all the recordings in your voice recorder. (Do not cut off recordings from recorder to
computer, this cannot delete file from recorder successfully, and still occupy the disk space)

The voice recorder has a limited storage at 8GB / 16GB, so after a while of using, it may be full of
storage, you need to back up it on your computer

We will regular update our E-book, based on our customer feedback. We hope to get more
interaction from your side, and let us know more we could do, you could visit more of this
information from our website:
http://blog.evistr.com/
http://evistr.com/

http://blog.evistr.com/
http://evistr.com/
http://blog.evistr.com
mailto:support-us@evistr.com
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